[bookmark: _Toc488831773]Math Editing in Microsoft Word: MathType and LEAN
[bookmark: _Toc488831774]Basic Overview 


MathType is a useful program that organizes mathematical equations into a clean visual/audible expression. We recommend using MathType for every equation, unless it is something as simple as 5 + 5 = 10 or anything of that sort. It is especially useful in creating equations such as  and  which are not easy to create using the Word Equation tools. In addition, the Word Equation Editor does not create accessible equations that can be read by a screen reader.  This section will briefly highlight some most important takeaways from the MathType Tutorial and then give a list of the most important shortcuts in the program which should be learned to some extent.
To open up the MathType program, while in Word, press (Ctrl + Alt + Q). This will be the fastest way to access the program. For reference, you can also hit the MathType tab at the top of the Word document and then click on either Inline or Display. 
[image: ]
The difference between the two are mentioned a couple times in the manual later on so don’t worry about that right now. After this is done, the Equation box should pop up. This is where you will type all of the necessary equations in your document. You will end up creating an Equation box for each equation in your document. It should look like the following image below.
[image: ]

The first two rows are operations grouped into their respective category. You can click on any of those images and a box of operations will appear next to it. You can see how this is going to work as you have all of the operations you need here to create any equation. It seems pretty intuitive, but there are many tips and tricks that can be learned to help create a professional looking document. 
[bookmark: _Toc488831775]Going Through MathType Tutorial: 
This section will highlight the main takeaways from the MathType Tutorial from top to bottom in the order of the tutorial. Make sure this is the first thing you must look at before starting any work in MathType. Please go through the Tutorial carefully. To access the tutorial:
· Click on the MathType tab in Word
· Either click Inline or Display under the MathType tab
· After the Equation box pops up, click on the Help tab 
[image: ]
· Click on MathType Tutorial
Or
Quick Shortcut: To access the Equation box even faster, press (Ctrl + Alt + Q) which opens the Inline tab. To quickly explain the difference between Inline and Display, the Inline tab will insert the equation directly where your cursor is. On the other hand, Display will automatically add 2 lines to the document and center the Equation in the line directly below the cursor. The new cursor will start at the beginning of the 2nd line down. If this is confusing, try both and you will see it is clear how they both work. No matter which way you open the Equation box, click on the Help tab and then the MathType Tutorial. 
You should be brought to a Contents tab with all of the Tutorials information when opened. The first 3 things in the Contents (highlighted below) are not as important to us as it is just a brief introduction to the new MathType 6.9 program.
[image: ]
Getting Started 
[image: ]
This may be the most useful part of the Tutorial so please be sure to go through this Tab carefully. After clicking on Getting Started, it will break into 3 subtabs. The first subtab labeled, MathType Installation, will not be useful to us unless for some reason we are having troubles with Installation issues. If this ever happens, come to this section. Otherwise, the Basic Tutorials and More Tutorials sections are what needs to be focused on. 
Basic Tutorials
Opening the Basic Tutorials tab will leave you with the following subtabs, shown below.
[image: ]
We recommend that you go through the Basic Tutorials and More Tutorials tabs with an open Equation box side-by-side so you can practice as you read. 
Most Important Takeaways from each section:
Fractions and Square Roots- 
· You do not need to use the spacebar when in the same equation. MathType will automatically put a space between characters to help fluidity of typing (This will be especially useful after you learn shortcuts). MathType actually has the spacebar disabled, so if you press it you will hear a “beep” and nothing will happen. You will only use the spacebar if you change the Style, which will be explained later. 
· Be sure to always know where your cursor (insertion point) is when typing. If you create a fraction or square root, you will need to click the empty box in the part of the equation you are adding your numbers. To create a fraction or square root, you can click on the associated icons at the top of the Equation box. Both are highlighted below. You can access all of the operations by finding them in this box. You will soon find out that this is a very slow way of creating equations and shortcuts will be necessary. Each operation has a keyboard shortcut (can be seen by hovering your mouse over any operation, and looking in the bottom left corner of the Equation box). Most will be listed in the Useful/Important Shortcuts section later on.
[image: ]
In the example shown below, you must click the highlighted portion (numerator) to add a number there. Let’s add a 9 in the numerator and a 2 in the denominator. To add the 2, either click on the bottom portion of the fraction or simply press the down arrow to move your insertion point. Now, if you want to get your insertion point out of the fraction, but still be under the square root, press the right arrow once. There is an “A” in this position. To get out of the entire root, press the right arrow one more time. There is a “B” in this position. You can perform the same movements by simply clicking on the area you want to type with your mouse. This is totally up to you, but it may help and be faster to become comfortable with moving the insertion point with the keyboard arrows.
[image: ]

Play around with the insertion point by mixing up fractions, roots, and any other operations you want to by moving around the equation with your arrows. For example, create something funky like the equation shown below and move the insertion point to where you want to edit to get an understanding of how it works.
[image: ]

Working with Microsoft Word- 
· Talks about difference between Inline equation tab and the Display equation tab as mentioned earlier. 
· After you are done with editing the equation, simply click on the X icon in the top right corner of the box to save the equation. This will pop-up after the first time you do this. You may like to see this every time, but many MathType users do not. If you'd rather the equation just go directly into the document, tick the Don't show this dialog from now on checkbox.
[image: ]

Sums, Subscripts, and Superscripts-
· This section talks about how to create Sums, Subscripts, and Superscripts and the shortcuts to each one. Again, as mentioned earlier, there will be a Shortcut Section in this manual so do not worry about the keyboard shortcuts just yet. It is useful to be familiar with where each operation is in case you ever forget the shortcut so please go through each operation to familiarize yourself with where you can find it later. You will most likely use the operation box at the top to create equations for the first couple weeks or so, but you will soon become familiar with the shortcuts after performing them multiple times. 
· It also highlights the insertion points again, and talks about how you can use the Tab key to move around the equation as well as the keyboard arrows. Playing around with this will help you understand how each works. 
Editing Old Equations-
· You can always edit old equations and can copy specific portions of an equation to help save time if you need to write it again. 
· Old documents serve as sources for new documents. 
· In any equation, you can edit certain parts by highlighting the portion you are interested in. 
· If you have something highlighted and then click an operation, the highlighted region will be inside the operation. For example, if we have “A”, we can highlight it and then apply the fraction operation to get:
[image: ]
We see that the A is automatically placed in the numerator. If we highlight “B” and apply the square root function (can either find the operation or use shortcut), than we see that it automatically puts the B under the root.

· We can also change the color of the font if needed. 
[image: ]

More Tutorials
Clicking on this tab will open the following subtabs:
[image: ] 
Most Important Takeaways from each section:
Font and Styles- 
· The most important part of the section is knowing the types of Styles of font. Familiarize yourself with what Styles you will apply to different parts of an equation. After reading the below text on Styles and practicing what it says, you will soon find out what the purpose of this function is. To find the ‘Style menu’, look at the image below indicating which tab it is under. 
[image: ][image: ]
Including Text in an Equation-
· Talks about the ‘Text” Style option in particular and gives an example on when to use it. This is a very important Style, so make sure you read this thoroughly. MathType automatically recognizes certain phrases and may distort the Style without you wanting to.
Using MathType’s Toolbar-
· You can edit the Equation box operations if you find that some are appearing more than others. You will need to press the Alt key and the symbol at the same time and drag it into the Toolbar which is highlighted below. This is only going to be needed if you are repeatedly pressing the same operation every time. We recommend learning the shortcut on reoccurring operations as this is the fastest way to access the operations.

[image: ] 

The rest of the More Tutorials section should be read over, but does not have a lot of super important stuff to cover. They will answer specific questions you have depending on what material you are working on. If you ever need to find something in the Tutorial but don’t know where to look, click on the Search tab near the Contents tab and type in what you are looking for. Example shown below. 
[image: ]

Using MathType
· The Equation box operations can all be edited to your specific preferences. If there’s anything you want to customize to make it easier for you, it can probably be done. Just remember that the lab computers are shared, so you may want to make sure that your additions do not transfer over to the next user’s profile. If so, you must change the preferences back to default. We recommend just learning the default settings that way every student is on the same page. 
· The most important subtab from this section is the Styles tab under Using Fonts. There is a screenshot of this in the earlier pages of this manual. Be sure you know the distinctions between these fonts. 

The rest of the tutorial should be looked over, but does not contain information that requires to be repeated. That being said, do not skip over it. It may answer last questions you may have up to this point. Now you will see the list of Shortcuts that we have found useful in the lab. Depending on what you are working on, some operations will come up more than others. Just be sure to remember shortcuts of the relevant material you are working on.
[bookmark: _Toc488831776]Useful/Important Shortcuts
Here are a list of important shortcuts that are commonly used (Symbol | Operation | Shortcut). Below are screenshots with a highlighted box that designates where the operations can be found. 

Relational symbols
[image: ]
	

	Less than or equal to
	(Ctrl + K, ,) This means press Ctrl and K at the same time, and then press , after. The , after the K means “then”. And intuitively, + means at the same time.

	

	Greater than or equal to
	(Ctrl + K, .) This means press Ctrl and K at the same time, and then press . after.

	

	Not equal to
	(Ctrl + K, +) For the + at the end, you need to press (Shift + =).




Embellishments
[image: ]
	

	Over-bar
	Highlight the number “x”, and then press (Ctrl + _). To do _, press (Shift + -)

	

	tilde
	Highlight the number “y”, and then press (Ctrl + `). ` is the symbol to the left of the 1 on the keyboard, not the quotation key. 




Operator symbols
[image: ]
	
 
	Dot operator
	(Ctrl + Shift + K, .) Press Ctrl, Shift, K at the same time, and then press .

	

	Multiplication
	(Ctrl + K, T)



Arrow Symbols
[image: ]
	

	(Ctrl + K, Right)

	

	(Ctrl + K, Alt + Left)




Logical Symbols
[image: ]
	
 
	For all
	(Ctrl + Shift + K, A)

	

	For every
	(Ctrl + Shift + K, B)




Set Theory Symbols
[image: ]
	

	Is an element of
	(Ctrl + K, E)

	

	Is not an element of
	(Ctrl + K, Shift + E)

	

	Union
	(Ctrl + K, U)

	

	Intersection
	(Ctrl + K, X)

	

	Subset of
	(Ctrl + K, C)

	

	Not a subset of
	(Ctrl + K, Shift + C)




Miscellaneous symbols
[image: ]
	

	Real numbers
	(Ctrl + D, Shift + R)

	

	Integers
	(Ctrl + D, Shift + Z)

	

	Complex numbers
	(Ctrl + D, Shift + C)

	

	Rational numbers
	(Ctrl + D, Shift + Q)

	

	Natural numbers
	(Ctrl + D, Shift + N)

	

	Infinity
	(Ctrl + K, I)

	

	degree
	(Ctrl + Shift + K, D)




Lower Case Greek Letters
[image: ]
	

	Alpha
	(Ctrl + G, A)

	

	Beta
	(Ctrl + G, B)

	

	Delta
	(Ctrl + G, D)

	

	Epsilon
	(Ctrl + G, E)

	

	Phi
	(Ctrl + G, F)

	

	Gamma
	(Ctrl + G, G)

	

	Mu
	(Ctrl + G, M)

	

	Pi
	(Ctrl + G, P)

	

	Theta
	(Ctrl + G, Q)

	

	Sigma
	(Ctrl + G, S)

	

	Tau
	(Ctrl + G, T)




Uppercase Greek Letters
[image: ]
	

	Delta
	(Ctrl + G, Shift + D)

	

	Gamma
	(Ctrl + G, Shift + G)

	

	Phi
	(Ctrl + G, Shift + F)

	

	Sigma
	(Ctrl + G, Shift + S)

	

	Omega
	(Ctrl + G, Shift + W)




Fence Templates
[image: ]
	

	Parentheses, or round brackets
	(Ctrl + 9)

	

	Brackets, or square brackets
	(Ctrl + [ )

	

	Braces, or curly brackets
	(Ctrl + { )





Fractions and Radicals
[image: ]
	

	Fraction
	(Ctrl + F)

	

	Square root
	(Ctrl + R)

	

	nth root
	(Ctrl + T, N)




Subscript and Superscript templates
[image: ]
	

	Superscript
	(Ctrl + H)

	

	Subscript
	(Ctrl + L)

	

	Superscript and Subscript
	(Ctrl + J)




Summation Templates
[image: ]
	

	Summation with no limits
	(Ctrl + T, Shift + S)

	

	Summation with limits
	(Ctrl + T, S)





Integral Templates
[image: ]
	

	Integral with no limits
	(Ctrl + Shift + I, !)

	

	Integral with limits
	(Ctrl + I)




Underbar and Overbar Templates
[image: ]
	

	Tilde
	(Ctrl + ^, ~)

	

	Hat
	(Ctrl + ^, 6)

	

	Over-bar
	(Ctrl + ^, -)




Matrix Templates
[image: ]
	

	2 row, 2 column matrix
	(Ctrl + M, 2)

	

	3 row, 3 column matrix
	(Ctrl + M, 3)




Also notice the tabs below the main operations. They contain a lot more operations that are less common.
[image: ]


[bookmark: _Toc488831777]Practice 
Here are just a few commonly seen equations. Open up a new document and a new Equation box so you can try and re-create the following equations. If you need help or can’t figure it out, click on the equations in this text to see how it was created:
1. 
 

2. 
 

3. 
 

4. 
 

5. 
 
6. [bookmark: _GoBack]

[bookmark: _Toc488831778]MathType -LEAN
Occasionally, converting the math using MathType in a Word document is not the last step in the process.  Some screen readers need to have the equations converted to an object that can be read.  This last step is called LEAN, and is a simple overlay that gets applied to files once the MathType is completed. This step SHOULD NOT be taken if you have not been instructed specifically to do so.
[bookmark: _Toc488831779]How to convert to LEAN
1. After all equations are in MathType you can run Lean over the document. 
2. With the document open, select all of the text. [ctrl+A]
3. Find the LEAN In Shortcut key on your desktop
[image: ]

4. Double click this button and it should process all the equations. 
5. When you are finished make sure to SAVE AS and add “_Lean” to the name of the file. You MUST do this, for the Lean application work properly. The LEANed files can be moved into a new Folder in the WORD folder, labeled as LEAN.
[bookmark: _Toc488831780]Example Textbooks
There are textbooks on the file server that are good examples of work that has been done using MathType and Lean.  They are:
· Neural Networks - Rojas –
· Statistical Reasoning for the Behavioral Sciences
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Color
‘You can customize the Color menu by choosing Edit Color Menu in the MathType menu under Format > Color.
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Style menu

‘The commands on this menu assign a style to the selected part of the equation or subsequently typed characters. The current style or the style of the selection (i it is all
of ane style) is shown in the status bar.

Math Ctri+Plus

‘The Math style is the default style for typing mathematics. When the current style is Math, MathType assigns the Variable, Function, Number, or Symbol style
‘automatically based on what you type. fMathType recognizes a sequence of alphabetic characters as a standard abbreviation for a mathematical function (e.g. sin for the
sine trigonometric function), it will use the Function style. Al other alphabetic characters are assigned the Viariable style.

Text Ctrl+Shift+E

Use the Text style when you want to type a sentence or phrase in English (or other natural language) instead of in math. When in Text style, the spacebar will be
enabled to allow you to enter spaces between words.

Function Ctrl+Shift+F
Use this command to create a function that was not automaticaly given the Function style. (See also the Functions Recognized Dialog.)
Variable Ctrl+Shift+V

Use this command to assign the Variable style to characters that would otherwise be given a different style. For example, sin is a function
‘automatically assign the Function style. You would use this command if you actually wanted to enter three adjacent variables, "s", ", and

Greek- Symbol Ctrl+Shift+G

“This command allows you to use the keyboard to type Greek letters. Once this style is active, the letters you type will be given either the L.C. Greek or U.C. Greek style,
depending on whether you type a lower-case (small) or upper-case (capital) letter.

Often it is easier to enter a single Greek letter by using the Cirl+G One-shot Keyboard Shortcut or by using the Greek symbol palette. This avoids having to switch into
Greek style and back again, because the one-shot only affects the very next keystroke.

Vector- Matrix Ctrl+Shift+B

Mathematical vectors and matrices are sometimes given a bold character style. Use this command to assign the Vector- Matrix style to selected text or subsequently
typed characters.

Often it is easier to enter a matrix or vector by using the Ctrl+8 One-shot Keyboard Shortcut . This avoids having to switch into Vector-Matrix style and back again.

User 1 Ctrl+Shift+U
User 2 Ctrl+Alt+Shift+U

‘The User 1 and User 2 styles may be used any way you like. Use the Define Styles Dialog to assign a font and character style to each. These styles are used most often to
enter characters from alternate alphabets, such as Blackboard Bold (double-stroked) or Fraktur (Old German) .

Other
“This command brings up the Other Style dialog, allowing you to assign a specific font and character style to selected text or subsequently typed characters.

me that MathType will

‘This command brings up the Define Styles dialog, allowing you to change the font and character style assigned to each style for the entire equation or for new equations.
‘You can also invoke this command by double-clicking on the Style area of the status bar.
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